


National	Instruments	License	Manager	Help
April	2008	Edition,	Part	Number	371136D-01
Use	the	National	Instruments	License	Manager	to	activate	and	manage
your	licenses	or	configure	NI	products	on	your	system	to	obtain	licenses
from	network	license	servers.
To	navigate	this	help	file,	use	the	Contents,	Index,	and	Search	tabs	to
the	left	of	this	window.
For	more	information	about	this	help	file,	refer	to	the	following	topics:
Conventions—formatting	and	typographical	conventions	in	this	help	file
Important	Information
Technical	Support	and	Professional	Services
To	comment	on	National	Instruments	documentation,	refer	to	the	National
Instruments	Web	site.
©	2004–2008	National	Instruments	Corporation.	All	rights	reserved.

javascript:WWW(WWW_Feedback)


License	Management	Overview
License	management	is	the	process	of	controlling	access	to	products
based	on	an	explicit	license	agreement.	Certain	National	Instruments
software	products	require	an	activated	license	in	order	to	execute.
You	must	acquire	and	activate	a	license	before	you	can	use	a	product	in
full-featured,	nonexpiring	mode.	The	activation	process	involves	using
the	NI	Activation	Wizard	to	send	the	following	information	to	National
Instruments:

The	product	you	are	activating
The	version	of	the	product	you	are	activating
The	serial	number	of	the	product	you	are	activating
Your	name
Your	organization
A	computer	ID	that	uniquely	identifies	your	computer

National	Instruments	uses	this	information	to	generate	an	activation
code,	which	you	then	use	to	activate	the	product	on	your	system.
National	Instruments	does	not	use	this	information	for	any	other	purpose.
Refer	to	the	Software	Licensing	Information	Privacy	topic	for	information
on	the	National	Instruments	privacy	policy	regarding	your	personal
information.
The	NI	Activation	Wizard	offers	a	variety	of	options	you	can	use	to	obtain
an	activation	code	from	National	Instruments,	including	automatically
through	an	Internet	connection	or	using	a	Web	browser,	email	client,
telephone	or	fax	machine.	Activation	is	available	24	hours	a	day.

Note		Refer	to	National	Instruments	activation	Web	site,
ni.com/activate,	for	the	latest	information	regarding	activation	and
license	management.

For	information	on	more	NI	License	Manager	tasks,	refer	to	What	Do	You
Want	to	Do?
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The	NI	License	Manager	Environment
The	left	pane	of	NI	License	Manager	displays	all	licenses	accessible	by
your	computer,	organized	hierarchically	in	a	tree	control	(NI	License
Manager	tree).	The	right	pane	contains	context-sensitive	information
based	on	the	item	you	have	selected	in	the	NI	License	Manager	tree.	The
following	table	provides	a	description	of	each	type	of	item	that	could
appear	in	the	tree.

Icon Label Description Right	Pane
Contents

Local	Licenses Displays	all	locally	installed
licenses.

Help	links

networkServer Displays	all	licenses	on	a
network	license	server.

Displays	the
server	name	and
status.

parentProduct(icon
may	vary)

Specifies	the	parent
product.

Displays	Web
help	provided
from	ni.com,	if
enabled.

product An	activated	or	otherwise
fully	featured,	nonexpiring
license.

Specific
information	about
the	license
including:

product
name
associated
software
product
version
license
expiration
date*
license
status*
agreement
ID**



agreement
company**
agreement
expiration**

*Not	available	on
network	licenses
**Available	on
network	licenses
only

product A	nonexpiring	evaluation
license.

Same	as	above

product An	activated	or	otherwise
fully	featured,	expiring
license.

Same	as	above

product An	expiring	evaluation
license.

Same	as	above

product A	fully	featured	license	that
has	expired.

Same	as	above

product An	evaluation	license	that
has	expired.

Same	as	above

product An	unlicensed	product	or	a
product	being	served	from	a
network	license	server.

Same	as	above

product A	product	that	you	prevent
from	requesting	permissions
from	the	parent	license
server.

Same	as	above

product An	unusable	license,
possibly	due	to	a	corrupted
license	file,	or	a	license	file
that	requires	reactivation.

Same	as	above

Modules Contains	add-on	modules
for	a	parent	product.

None

Toolkits Contains	add-on	toolkits	for
a	parent	product.

None



message An	informational	message. Extended
description	of	the
message

The	Options	menu	contains	the	following	options:

Option Description
Activate Starts	the	NI	Activation	Wizard	to	activate	a	product.
Display
Computer
Information

Displays	your	system's	computer	ID	and	computer	name.

Install
License	File

Installs	a	new	license	file	on	your	system.

Refresh Refreshes	the	contents	of	NI	License	Manager.
Preferences Sets	Web	help,	start-up,	and	network	license	server

preferences.	You	can	set	the	following	options:
Use
Network
License
Servers

Check	this	box	and	then	enter	the	names	of	your
network	license	servers	to	use	this	option.	NI
License	Manager	first	checks	a	network	server
location	for	a	license	before	checking	your	local
license	server.	You	can	enter	either	a	server
name,	the	server's	network	name,	or	the	server's
IP	address.	For	more	information,	refer	to	Using
a	Network	License	Server.

Show
Web
Help

Shows	or	hides	supplemental	information
provided	from	ni.com.

		Note		Internet	Explorer	5.0	or	higher	is
required	to	view	Web	help.

Start
Local
License
Server
on
System
Start

Starts	the	local	license	server	on	system	startup.
Most	products	do	not	require	the	local	license
server.	The	controls	for	this	feature	appear	only	if
you	install	LabVIEW	Remote	Panel	Connections
8.5	or	earlier.	For	more	information,	refer	to
Using	the	Local	License	Server.	



	Note		This	preference	requires	you	to	be
logged	in	as	an	Administrator,	and	is	not
available	on	Microsoft	Windows	Vista.

Exit Exits	NI	License	Manager.

The	Toolbar	contains	the	following	items:

Icon Button Description
Activate Starts	the	NI	Activation	Wizard	to	activate	a	product.
Display
Computer
Information

Displays	your	system's	computer	ID	and	computer
name.

Start/Stop
Local
License
Server

Starts	or	stops	the	local	license	server.	Most	products
do	not	require	the	local	license	server.	The	controls	for
this	feature	appear	only	if	you	install	LabVIEW	Remote
Panel	Connections	8.5	or	earlier.	For	more
information,	refer	to	Using	the	Local	License	Server.

	



Glossary
A 	 C 	 E 	 F 	 L 	 N 	 P 	 S



A
activated
license

Allows	a	product	to	be	used	on	one	particular	computer.	You
cannot	use	this	license	file	on	another	computer.

activation The	process	of	activating	a	product	for	use	on	your	computer.
activation
code

A	20-character	value	that	is	generated	by	National
Instruments	and	used	during	the	activation	process.



C
computer
ID

A	16-character	value	that	uniquely	identifies	your	computer.
It	is	used	by	National	Instruments	in	the	activation	code
generation	process.

computer-
based
license

A	license	for	a	single	computer	that	allows	multiple	users
and	a	single	home	installation.

concurrent
license

A	license	type	where	licenses	are	assigned	dynamically	on	a
first-come,	first-served	basis.	Concurrent	licenses	can	be
managed	or	unmanaged.	Managed	concurrent	licenses
require	users	or	computers	to	have	permissions	assigned	in
NI	VLM.	An	unlimited	number	of	users	or	computers	can
have	permissions	for	managed	concurrent	licenses.
Unmanaged	concurrent	licenses	do	not	require	users	or
computers	to	have	permissions	assigned	in	NI	VLM.	Their
use	is	unrestricted.



E
evaluation
license

Allows	a	product	to	be	used	with	certain	limitations,	such	as
reduced	functionality	or	limited	execution	time.



F
family A	keyword	used	in	command-line	activation	to	represent	a

collection	of	related	products	(for	example,	LabVIEW	Base,
LabVIEW	Full,	LabVIEW	Professional).	Refer	to	Automating
Activation	for	more	information.



L
license The	legal	right	to	use	a	particular	product	under	the	terms	of	a

license	agreement.
license
file

A	file	that	contains	a	license	for	one	or	more	products.	Typically,
there	is	at	least	one	license	file	for	each	product	on	your
system.
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N
named-user
license

A	license	for	a	single	person,	limited	to	three
installations	per	license,	where	each	license	is	used
only	on	one	computer	at	a	time.	This	license	also	allows
a	home	license.

NI	Activation
Wizard

Guides	you	through	the	activation	process.	To	launch
the	NI	Activation	Wizard,	click	the	Activate	button	in
the	NI	License	Manager	toolbar,	select	the
Options»Activate	menu	item,	or	double-click	on	the
product	you	want	to	activate.

NI	License
Manager

A	utility	program	used	to	manage	various	tasks
associated	with	license	management	and	activation.

NI	Volume
License
Manager	(NI
VLM)

A	utility	program	used	to	administer	licenses	available
through	a	National	Instruments	Volume	License
Agreement.

numeric
computer	ID

A	25-character,	numeric	encoding	of	a	computer	ID	for
activating	a	product	over	the	telephone.

numeric
product/version

A	10-character,	numeric	encoding	of	a	product	and
version	for	activating	a	product	over	the	telephone.

numeric	serial
number

A	15-character,	numeric	encoding	of	a	serial	number	for
activating	a	product	over	the	telephone.



P
package A	keyword	used	in	command-line	activation	that	represents	a

specific	product.	Refer	to	Automating	Activation	for	more
information.

product A	software	component	that	requires	a	license	to	use.	A	product
can	be	a	single	product,	one	or	more	features	of	a	single
product,	or	a	bundle	of	several	products.



S
serial
number

An	alphanumeric	value	located	on	the	Certificate	of	Ownership
or	license	card	included	with	purchased	products.	The	serial
number	is	used	by	NI	in	the	activation	code	generation	process.

	



Activating	a	Product
You	must	activate	your	product	before	using	it	in	accordance	with	its
license	agreement.	To	activate	a	product,	you	must	first	purchase	a
license.	For	information	on	purchasing	licenses,	contact	your	local
National	Instruments	sales	representative	or	visit	ni.com/niglobal.
Once	you	have	purchased	a	license,	you	can	activate	your	product	using
the	NI	Activation	Wizard.	The	NI	Activation	Wizard	prompts	you	for	your
name,	your	organization,	and	the	serial	numbers	of	the	products	you	are
activating.	You	can	find	the	serial	number	on	the	Certificate	of	Ownership
or	license	card	included	with	each	product.	If	your	software	kit	does	not
include	a	Certificate	of	Ownership,	you	can	find	your	serial	number	on	the
product	packing	slip	or	on	the	shipping	label.
If	you	have	installed	a	previous	version	using	your	serial	number,	you	can
find	the	serial	number	by	selecting	the	Help»About	menu	item	within	the
application	or	by	selecting	your	product	within	NI	License	Manager.	You
can	also	contact	your	local	National	Instruments	branch.
To	activate	your	products,	click	the	Activate	button	on	the	toolbar	or
double-click	your	product	in	the	NI	License	Manager	tree	and	follow	the
NI	Activation	Wizard	prompts.	You	can	also	right-click	the	product	in	the
NI	License	Manager	tree	and	select	Activate.
Upon	successful	activation,	you	can	use	the	product	immediately.

Note		If	you	were	using	a	product	before	you	began	the	activation
process,	you	may	need	to	restart	it	for	the	change	to	take	effect.

Note		If	your	NI	software	is	licensed	through	a	volume	license
agreement,	you	do	not	need	to	activate	your	product.	Instead,	you
need	to	point	NI	License	Manager	to	a	network	server.	For	more
information,	refer	to	Using	a	Network	License	Server.
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Moving	an	Activated	Product	to	Another
Computer
To	transfer	your	software	to	another	computer,	install	and	activate	it	on
the	second	computer.	You	will	not	be	prohibited	from	transferring	your
software	from	one	computer	to	another.	If	you	exceed	the	number	of
computers	allowed	in	the	NI	Software	License	Agreement,	you	must
uninstall	the	extra	installations.

Note		If	your	organization	uses	NI	Volume	License	Manager	to
manage	NI	software	under	a	volume	license	agreement	(VLA),
notify	your	VLA	administrator	before	transferring	your	software	to
another	computer.
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Deactivating	a	Product
To	deactivate	a	product	and	return	the	product	to	the	state	it	was	in
before	you	activated	it,	right-click	the	product	in	the	NI	License	Manager
tree	and	select	Deactivate.	If	the	product	was	in	evaluation	mode	before
you	activated	it,	the	properties	of	the	evaluation	mode	may	not	be
restored.



Reactivating	a	Deactivated	Product
You	can	reactivate	a	deactivated	product	using	the	NI	Activation	Wizard.
If	you	saved	the	activation	code	from	a	previous	activation	for	this
computer,	select	Apply	one	or	more	20-character	activation	codes
previously	acquired	for	this	computer	and	follow	the	prompts.
Otherwise,	select	one	of	the	other	two	options	and	follow	the	NI
Activation	Wizard	prompts.
	



Using	a	Network	License	Server
You	can	check	out	licenses	from	a	network	server	if	your	company	has	a
Volume	License	Agreement	with	National	Instruments.



Using	a	Network	License	Server
Complete	the	following	steps	to	use	a	network	server:

1.	 Select	the	Options»Preferences	menu	item.
2.	 Click	the	Use	Network	License	Servers	checkbox.
3.	 Enter	the	names	of	the	network	servers,	separated	by	commas,

on	which	your	NI	products	should	check	for	licenses.	You	can
enter	either	a	server	name,	the	server's	network	name,	or	the
server's	IP	address.	You	can	also	configure	your	products	to	look
at	a	specific	port	on	a	network	server.	Enter	the	network	server
name	followed	by	colon	and	the	port	number:	server[:port].	For
example:

server
server:27000
server.domain.com:28432
127.0.0.2

are	all	legal	server	names.	When	no	port	is	specified,	27000	is
implied.	Ports	range	from	0-64000,	inclusive.

If	you	enter	server1,	server2:28001,	server3	and	then	launch	a
product	that	requires	a	license,	your	product	first	checks	port
27000	of	server1	for	a	valid	license,	then	moves	to	port	28001	of
server2,	port	27000	of	server3,	and	finally	your	local	system.	If
your	product	does	not	find	a	license	on	any	of	the	network	servers
or	your	local	system,	your	product	does	not	start.

Notes
If	you	are	running	NI	Volume	License	Manager	on
the	same	computer	as	NI	License	Manager,	you
must	set	your	network	license	server	to	localhost	or
127.0.0.1	to	check	out	a	license	from	the	licenses
being	served	by	your	local	NI	VLM.
Contact	your	volume	license	agreement	software
administrator	to	obtain	the	server	information.

4.	 Click	OK.



You	can	now	check	out	and	use	products	from	the	network	license
server.

Notes
A	License	Server	item	is	denoted	by	 	if	it	is	active	and	by	
	if	it	is	inactive.	The	right	pane	displays	the	server	name,

server	status,	administrator	information,	and	volume	license
agreement	information,	if	available.
If	you	need	to	check	out	licenses	from	a	"triple	redundant"
network	server,	list	all	three	server	names,	separated	by
commas,	in	this	box	to	properly	configure	your	client.

For	more	information	about	the	NI	Volume	License	Program,	refer	to
ni.com/vlp.
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Switching	between	Concurrent	Licenses
NI	License	Manager	looks	for	all	licenses	available	on	the	network
license	server.	If	your	NI	volume	license	agreement	includes	concurrent
licenses	for	multiple	types	of	the	same	product,	you	can	switch	between
concurrent	licenses	to	use	a	specific	product	type.
For	example,	if	you	have	concurrent	licenses	for	LabVIEW	Professional
and	LabVIEW	Full	and	you	need	only	LabVIEW	Full,	you	can	disable
license	checkout	for	LabVIEW	Professional	to	save	the	license	for	a
colleague	who	needs	its	features.
To	prevent	using	a	specific	network	license,	right-click	on	the	product
listed	under	a	network	license	server	and	select	Do	Not	Allow	License
Request.	The	Server	License	Request	status	reflected	in	the	right-hand
view	changes	to	Not	Allowed.

Notes:
Concurrent	license	switching	works	on	products	shipped	in
August	2008	or	later,	such	as	LabVIEW	8.6,	that	use
concurrent	licenses.
This	feature	is	available	only	for	concurrent	licenses	hosted
by	a	network	license	server.	If	you	are	using	managed
concurrent	licenses,	you	must	have	permission	assigned	on
the	network	license	server.	Contact	your	volume	license
agreement	software	administrator	for	assistance	assigning
permissions.

To	resume	using	the	product,	right-click	on	the	product	listed	under	a
network	license	server	and	select	Allow	License	Request.	The	Server
License	Request	status	reflected	in	the	right-hand	view	changes	to
Allowed.
	



Installing	a	License	File
You	may	need	to	install	onto	your	system	a	new	license	file	that	you
receive	from	National	Instruments	or	a	disconnected	or	home	license	file
that	you	received	from	a	network	license	server	administrator.	Select	one
of	the	following	methods	to	install	your	license:

Select	Options»Install	License	File	from	the	menu	and	choose
one	or	more	license	files	to	install.
Select	one	or	more	license	files	in	Windows	Explorer	and	drag
them	onto	the	NI	License	Manager	tree.

NI	License	Manager	updates	to	reflect	the	addition	of	the	new	license
files.	Remember,	you	still	might	need	to	activate	new	licenses.	For	more
information,	refer	to	Activating	a	Product.

Note		Disconnected	and	home	license	files	generated	by	NI
Volume	License	Manager	do	not	need	to	be	activated.
Note		To	permanently	remove	disconnected	and	home	license	files
from	your	computer,	right-click	a	licensed	product	in	the	NI	License
Manager	tree	and	select	Uninstall.

	



Activating	a	Product	for	Home	Use
To	activate	your	product	for	home	use,	as	allowed	in	your	license
agreement,	install	and	activate	the	product	on	your	home	computer	using
the	same	serial	number.

Note		If	your	organization	uses	NI	Volume	License	Manager,	notify
your	administrator	to	request	a	license	file	for	home	use.	After	you
install	the	product	and	the	license	file	on	your	home	computer,	you
do	not	have	to	activate.	Refer	to	Installing	a	License	File	for	more
information.

	

javascript:WWW(WWW_Eula)


Recovering	a	Deleted	or	Damaged	License	File
If	you	accidentally	delete	or	damage	a	license	file,	you	can	restore	it.
How	you	restore	your	license	file	depends	on	what	kind	of	license	file	you
need,	as	follows:

To	restore	a	license	file	installed	with	an	application,	perform	the
following	steps:

1.	 Browse	to	ni.com/downloads,	select	Drivers	and	Updates,
and	browse,	by	product,	to	the	appropriate	license	file.

2.	 Download	the	desired	evaluation	license	file.
3.	 Launch	NI	License	Manager	and	install	the	license	file	that

you	downloaded.	Refer	to	Installing	a	License	File	for	more
information	about	installing	a	license	file.

Note		If	you	have	a	damaged	license	file,	NI	License
Manager	asks	whether	you	want	to	overwrite	the
existing	file	when	you	install	a	new	license	file.	Click
Yes.

4.	 Activate	the	newly	installed	license.	Refer	to	Activating	a
Product	above	for	more	information.

To	restore	a	license	file	given	to	you	by	a	National	Instruments
Volume	License	Program	administrator	(either	a	disconnected	or	a
home	license	file),	contact	your	administrator	for	another	copy.
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Using	the	Local	License	Server
Note		Most	products	do	not	require	the	Local	License	Server.	The
controls	for	this	feature	remain	hidden	unless	you	have	installed
LabVIEW	Remote	Panel	Connections	8.5	or	earlier.

Use	the	Local	License	Server	to	manage	licenses	for	LabVIEW	Remote
panel	Connections	8.5	or	earlier	and	display	the	current	status	of	the
License	Server.	The	License	Server	consists	of	two	daemon	processes
(lmgrd	and	nilm)	that	run	as	services.
To	start	or	stop	an	inactive	server,	click	the	Start/Stop	Local	License
Server	button	on	the	NI	License	Manager	toolbar.	This	feature	requires
you	to	be	logged	in	as	an	Administrator,	and	is	not	available	on	Microsoft
Windows	Vista.

Note		If	you	use	LabVIEW	8.5	or	earlier,	you	cannot	manage	the
Local	License	Server	if	you	have	NI	Volume	License	Manager	(NI
VLM)	installed	on	the	same	computer	as	NI	License	Manager.
Consequently,	LabVIEW	Remote	Panel	Connections	cannot	be
used	if	NI	VLM	is	installed.	If	you	encounter	this	situation,	contact
National	Instruments	for	a	resolution.

	



Automating	Activation
If	you	are	a	license	administrator	or	if	you	are	responsible	for	transferring
NI	products	to	end	users,	you	can	automate	product	activation	and	add
network	license	servers	by	running	NI	License	Manager	from	a	command
line	or	from	a	batch	file.



What	do	you	want	to	do?
Launch	NI	Activation	Wizard.	This	command	is	equivalent	to
clicking	the	Activate	button	in	NI	License	Manager.

Syntax:	nilmUtil.exe	-all
Launch	NI	Activation	Wizard	with	a	preselected	package	or
family.	This	command	is	equivalent	to	right-clicking	on	a	product	or
family	in	NI	License	Manager	and	selecting	Activate	to	activate	a
product.

Package
Syntax:	nilmUtil.exe	-activate	"packagename	version"
Example:	nilmUtil.exe	-activate	"LabVIEW_PDSM_PKG	8.0500"	

Family
Syntax:	nilmUtil.exe	-family	"family"
Example:	nilmUtil.exe	-family	"LabVIEW_ADE_080600"	

NI	Activation	Wizard	launches	and	steps	you	through	the	process
of	activating	your	product.
Activate	a	product	silently.	You	can	activate	a	product	without
launching	the	NI	Activation	Wizard	using	command-line	flags.	The
-s	flag	triggers	a	silent	activation.	You	can	use	the	-s	flag	only	with
the	-family	or	-activate	flags.

Note		This	option	requires	an	Internet	connection	that	allows
access	to	ni.com	over	an	encrypted	web	connection	(https).

Syntax:	nilmUtil.exe	-s	-activate	"packagename"	-serialnumber
"serialnumber"	[-firstname	"firstname"]	[-lastname	"lastname"]	[-
organizationname	"organizationname"]

Example:	nilmUtil.exe	-s	-activate	"LabVIEW_PDSM_PKG	8.0500"	-
serialnumber	"A111A1A11"	-firstname	"Jane"	-lastname	"Doe"	-
organizationname	"Company	Name"	

NI	License	Manager	silently	activates	your	product.
Note		If	you	enter	incorrect	or	incomplete	information	such



as	a	invalid	serial	number,	activation	may	fail.	In	order	not	to
interfere	with	your	remaining	automation	scripts,	no	error
message	will	appear.	You	must	activate	manually	before	you
can	use	your	software.

Silently	point	a	computer	to	a	network	license	server	to	check
out	licenses.	This	command	is	equivalent	to	using	the
Options»Preferences	menu	item	to	add	a	license	server.

Syntax:	nilmUtil.exe	-addservers	servername[:portnumber]
[,servername[:portnumber],...]

Examples:
nilmUtil.exe	-addservers	server1
nilmUtil.exe	-addservers	server1:28000
nilmUtil.exe	-addservers	server1:28000,server2	

You	can	now	use	NI	License	Manager	to	check	out	licenses	from
the	newly	added	network	license	server.



Command-line	Flags
NI	License	Manager	command-line	flags	are	listed	in	the	following	table.

Note		Flag	order	does	not	matter.
Flag Description
-s Activates	a	family	or	feature	in	silent	mode	(-activate

or	-family).	If	you	use	silent	mode,	you	must	supply
the	serial	number.	First	name,	last	name,	and
organization	name	are	optional	if	they	can	be
loaded	from	the	computer	preferences.

-activate Activates	a	specific	version	of	a	single	package
using	the	Internet.	You	must	provide	the	package
name	or	feature	and	the	version.

You	can	find	the	package	name	in	your	license	file,
which	is	located	in	the	\Program	Files\National
Instruments\Shared\License	Manager\Licenses
directory.	Open	the	license	file	in	a	text	editor	and
look	for	the	PACKAGE	line.	Copy	the	text	that
includes	_PKG	and	the	version	number	that	follows
nilm	on	the	PACKAGE	line.

-family Activates	a	single	family	using	the	Internet.	You
must	provide	the	family	name	or	feature	and	the
version.

You	can	find	the	family	name	in	your	license	file,
which	is	located	in	the	\Program	Files\National
Instruments\Shared\License	Manager\Licenses
directory.	Open	the	license	file	in	a	text	editor	and
look	for	the	FAMILY=	line.	Copy	the	text	after	the
equals	sign	that	includes	the	family	name	and
version.

-all Launches	NI	Activation	Wizard	for	any	installed
products.	This	command	cannot	be	used	silently.

-all	product Launches	NI	Activation	Wizard	for	a	preselected
product.	This	command	cannot	be	used	silently.



-serialnumber The	serial	number	of	the	product.	You	must	provide
the	serial	number	of	the	feature	or	family	to	activate
when	using	-s	flag.

-firstname The	user's	first	name.	This	flag	is	optional	if	the	first
name	can	be	loaded	from	the	computer
preferences.

-lastname The	user's	last	name.	This	flag	is	optional	if	the	last
name	can	be	loaded	from	the	computer
preferences.

-organizationname The	user's	organization	or	company.	This	flag	is
optional	if	the	organization	name	can	be	loaded
from	the	computer	preferences.

-addservers Adds	a	server	to	a	list	of	existing	servers.	The	port
number	is	optional.	servername	is	required.	Port
27000	is	the	default	if	no	port	is	specified.

Note		If	you	have	numerous	licenses	to	activate,	consider	using	NI
Volume	License	Manager	with	a	Volume	License	Agreement.	For
more	information,	visit	ni.com/vlp.
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Using	Help
Conventions
Navigating	Help
Searching	Help
Printing	Help	File	Topics
	



Conventions
This	help	file	uses	the	following	conventions:

» The	»	symbol	leads	you	through	nested	menu	items
and	dialog	box	options	to	a	final	action.	The	sequence
File»Page	Setup»Options	directs	you	to	pull	down	the
File	menu,	select	the	Page	Setup	item,	and	select
Options	from	the	last	dialog	box.

[	] Square	brackets	enclose	optional	items—for	example,
[response].
This	icon	denotes	a	tip,	which	alerts	you	to	advisory
information.
This	icon	denotes	a	note,	which	alerts	you	to	important
information.

bold Bold	text	denotes	items	that	you	must	select	or	click	on
in	the	software,	such	as	menu	items	and	dialog	box
options.	Bold	text	also	denotes	parameter	names,
emphasis,	or	an	introduction	to	a	key	concept.

green Underlined	text	in	this	color	denotes	a	link	to	a	help
topic,	help	file,	or	Web	address.

italic Italic	text	denotes	variables	or	cross	references.	This
font	also	denotes	text	that	is	a	placeholder	for	a	word	or
value	that	you	must	supply.

monospace Text	in	this	font	denotes	text	or	characters	that	you
should	enter	from	the	keyboard,	sections	of	code,
programming	examples,	and	syntax	examples.	This
font	is	also	used	for	the	proper	names	of	disk	drives,
paths,	directories,	programs,	subprograms,
subroutines,	device	names,	functions,	operations,
variables,	filenames,	and	extensions.

monospace	italic Italic	text	in	this	font	denotes	text	that	is	a	placeholder
for	a	word	or	value	that	you	must	supply.

	



Navigating	Help	(Windows	Only)
To	navigate	this	help	file,	use	the	Contents,	Index,	and	Search	tabs	to
the	left	of	this	window	or	use	the	following	toolbar	buttons	located	above
the	tabs:

Hide—Hides	the	navigation	pane	from	view.
Locate—Locates	the	currently	displayed	topic	in	the	Contents	tab,
allowing	you	to	view	related	topics.
Back—Displays	the	previously	viewed	topic.
Forward—Displays	the	topic	you	viewed	before	clicking	the	Back
button.
Options—Displays	a	list	of	commands	and	viewing	options	for	the
help	file.

	



Searching	Help	(Windows	Only)
Use	the	Search	tab	to	the	left	of	this	window	to	locate	content	in	this	help
file.	If	you	want	to	search	for	words	in	a	certain	order,	such	as	"related
documentation,"	add	quotation	marks	around	the	search	words	as	shown
in	the	example.	Searching	for	terms	on	the	Search	tab	allows	you	to
quickly	locate	specific	information	and	information	in	topics	that	are	not
included	on	the	Contents	tab.



Wildcards
You	also	can	search	using	asterisk	(*)	or	question	mark	(?)	wildcards.
Use	the	asterisk	wildcard	to	return	topics	that	contain	a	certain	string.	For
example,	a	search	for	"prog*"	lists	topics	that	contain	the	words
"program,"	"programmatically,"	"progress,"	and	so	on.
Use	the	question	mark	wildcard	as	a	substitute	for	a	single	character	in	a
search	term.	For	example,	"?ext"	lists	topics	that	contain	the	words
"next,"	"text,"	and	so	on.

Note		Wildcard	searching	will	not	work	on	Simplified	Chinese,
Traditional	Chinese,	Japanese,	and	Korean	systems.



Nested	Expressions
Use	nested	expressions	to	combine	searches	to	further	refine	a	search.
You	can	use	Boolean	expressions	and	wildcards	in	a	nested	expression.
For	example,	"example	AND	(program	OR	VI)"	lists	topics	that	contain
"example	program"	or	"example	VI."	You	cannot	nest	expressions	more
than	five	levels.



Boolean	Expressions
Click	the	 	button	to	add	Boolean	expressions	to	a	search.	The	following
Boolean	operators	are	available:

AND	(default)—Returns	topics	that	contain	both	search	terms.	You
do	not	need	to	specify	this	operator	unless	you	are	using	nested
expressions.
OR—Returns	topics	that	contain	either	the	first	or	second	term.
NOT—Returns	topics	that	contain	the	first	term	without	the	second
term.
NEAR—Returns	topics	that	contain	both	terms	within	eight	words
of	each	other.



Search	Options
Use	the	following	checkboxes	on	the	Search	tab	to	customize	a	search:

Search	previous	results—Narrows	the	results	from	a	search	that
returned	too	many	topics.	You	must	remove	the	checkmark	from
this	checkbox	to	search	all	topics.
Match	similar	words—Broadens	a	search	to	return	topics	that
contain	words	similar	to	the	search	terms.	For	example,	a	search
for	"program"	lists	topics	that	include	the	words	"programs,"
"programming,"	and	so	on.
Search	titles	only—Searches	only	in	the	titles	of	topics.

	



Printing	Help	File	Topics	(Windows	Only)
Complete	the	following	steps	to	print	an	entire	book	from	the	Contents
tab:

1.	 Right-click	the	book.
2.	 Select	Print	from	the	shortcut	menu	to	display	the	Print	Topics

dialog	box.
3.	 Select	the	Print	the	selected	heading	and	all	subtopics	option.

Note		Select	Print	the	selected	topic	if	you	want	to	print
the	single	topic	you	have	selected	in	the	Contents	tab.

4.	 Click	the	OK	button.



Printing	PDF	Documents
This	help	file	may	contain	links	to	PDF	documents.	To	print	PDF
documents,	click	the	print	button	located	on	the	Adobe	Acrobat	Viewer
toolbar.
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Warranty
The	media	on	which	you	receive	National	Instruments	software	are
warranted	not	to	fail	to	execute	programming	instructions,	due	to	defects
in	materials	and	workmanship,	for	a	period	of	90	days	from	date	of
shipment,	as	evidenced	by	receipts	or	other	documentation.	National
Instruments	will,	at	its	option,	repair	or	replace	software	media	that	do	not
execute	programming	instructions	if	National	Instruments	receives	notice
of	such	defects	during	the	warranty	period.	National	Instruments	does	not
warrant	that	the	operation	of	the	software	shall	be	uninterrupted	or	error
free.
A	Return	Material	Authorization	(RMA)	number	must	be	obtained	from
the	factory	and	clearly	marked	on	the	outside	of	the	package	before	any
equipment	will	be	accepted	for	warranty	work.	National	Instruments	will
pay	the	shipping	costs	of	returning	to	the	owner	parts	which	are	covered
by	warranty.
National	Instruments	believes	that	the	information	in	this	document	is
accurate.	The	document	has	been	carefully	reviewed	for	technical
accuracy.	In	the	event	that	technical	or	typographical	errors	exist,
National	Instruments	reserves	the	right	to	make	changes	to	subsequent
editions	of	this	document	without	prior	notice	to	holders	of	this	edition.
The	reader	should	consult	National	Instruments	if	errors	are	suspected.
In	no	event	shall	National	Instruments	be	liable	for	any	damages	arising
out	of	or	related	to	this	document	or	the	information	contained	in	it.
EXCEPT	AS	SPECIFIED	HEREIN,	NATIONAL	INSTRUMENTS	MAKES
NO	WARRANTIES,	EXPRESS	OR	IMPLIED,	AND	SPECIFICALLY
DISCLAIMS	ANY	WARRANTY	OF	MERCHANTABILITY	OR	FITNESS
FOR	A	PARTICULAR	PURPOSE.	CUSTOMER'S	RIGHT	TO	RECOVER
DAMAGES	CAUSED	BY	FAULT	OR	NEGLIGENCE	ON	THE	PART	OF
NATIONAL	INSTRUMENTS	SHALL	BE	LIMITED	TO	THE	AMOUNT
THERETOFORE	PAID	BY	THE	CUSTOMER.	NATIONAL
INSTRUMENTS	WILL	NOT	BE	LIABLE	FOR	DAMAGES	RESULTING
FROM	LOSS	OF	DATA,	PROFITS,	USE	OF	PRODUCTS,	OR
INCIDENTAL	OR	CONSEQUENTIAL	DAMAGES,	EVEN	IF	ADVISED	OF
THE	POSSIBILITY	THEREOF.	This	limitation	of	the	liability	of	National
Instruments	will	apply	regardless	of	the	form	of	action,	whether	in
contract	or	tort,	including	negligence.	Any	action	against	National
Instruments	must	be	brought	within	one	year	after	the	cause	of	action



accrues.	National	Instruments	shall	not	be	liable	for	any	delay	in
performance	due	to	causes	beyond	its	reasonable	control.	The	warranty
provided	herein	does	not	cover	damages,	defects,	malfunctions,	or
service	failures	caused	by	owner's	failure	to	follow	the	National
Instruments	installation,	operation,	or	maintenance	instructions;	owner's
modification	of	the	product;	owner's	abuse,	misuse,	or	negligent	acts;
and	power	failure	or	surges,	fire,	flood,	accident,	actions	of	third	parties,
or	other	events	outside	reasonable	control.
	



Copyright
Under	the	copyright	laws,	this	publication	may	not	be	reproduced	or
transmitted	in	any	form,	electronic	or	mechanical,	including	photocopying,
recording,	storing	in	an	information	retrieval	system,	or	translating,	in
whole	or	in	part,	without	the	prior	written	consent	of	National	Instruments
Corporation.
National	Instruments	respects	the	intellectual	property	of	others,	and	we
ask	our	users	to	do	the	same.	NI	software	is	protected	by	copyright	and
other	intellectual	property	laws.	Where	NI	software	may	be	used	to
reproduce	software	or	other	materials	belonging	to	others,	you	may	use
NI	software	only	to	reproduce	materials	that	you	may	reproduce	in
accordance	with	the	terms	of	any	applicable	license	or	other	legal
restriction.
	



Trademarks
National	Instruments,	NI,	ni.com,	and	LabVIEW	are	trademarks	of
National	Instruments	Corporation.	Refer	to	the	Terms	of	Use	section	on
ni.com/legal	for	more	information	about	National	Instruments	trademarks.
FireWire®	is	the	registered	trademark	of	Apple	Computer,	Inc.
Handle	Graphics®,	MATLAB®,	Real-Time	Workshop®,	Simulink®,
Stateflow®,	and	xPC	TargetBox®	are	registered	trademarks,	and
TargetBox™	and	Target	Language	Compiler™	are	trademarks	of	The
MathWorks,	Inc.
Tektronix®	and	Tek	are	registered	trademarks	of	Tektronix,	Inc.
Other	product	and	company	names	mentioned	herein	are	trademarks	or
trade	names	of	their	respective	companies.
Members	of	the	National	Instruments	Alliance	Partner	Program	are
business	entities	independent	from	National	Instruments	and	have	no
agency,	partnership,	or	joint-venture	relationship	with	National
Instruments.
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Software	Licensing	Information	Privacy
Note		For	the	latest	version	of	this	policy,	refer	to	the	Software
Licensing	Information	Privacy	Web	site.

Any	information	you	provide	to	generate	a	software	license	will	only	be
used	to	manage	the	software	to	ensure	compliance	with	the	applicable
license.	Otherwise,	it	will	not	be	shared	with	any	other	third	parties	nor
will	it	be	entered	into	NI's	marketing	and	customer	database.	If	you	are
within	the	European	Union	(the	"EU")	you	should	note	that	the	EU	has
deemed	the	United	States	to	have	inadequate	data	protection	laws.
However,	providing	this	information	is	required	for	your	use	of	the
licensed	software.	Accordingly,	by	providing	this	information,	you	are
consenting	to	its	transfer	outside	of	the	EU	for	the	limited	purpose	set
forth	above.
If	you	choose	to	register	your	software	or	submit	NI	Volume	License
Manager	activity	logs	with	user	information,	your	information	will	be
protected	according	to	the	National	Instruments	Privacy	Policy.
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Patents
For	patents	covering	National	Instruments	products,	refer	to	the
appropriate	location:	Help»Patents	in	your	software,	the	patents.txt	file	on
your	CD,	or	ni.com/patents.
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WARNING	REGARDING	USE	OF	NATIONAL
INSTRUMENTS	PRODUCTS
(1)	NATIONAL	INSTRUMENTS	PRODUCTS	ARE	NOT	DESIGNED
WITH	COMPONENTS	AND	TESTING	FOR	A	LEVEL	OF	RELIABILITY
SUITABLE	FOR	USE	IN	OR	IN	CONNECTION	WITH	SURGICAL
IMPLANTS	OR	AS	CRITICAL	COMPONENTS	IN	ANY	LIFE	SUPPORT
SYSTEMS	WHOSE	FAILURE	TO	PERFORM	CAN	REASONABLY	BE
EXPECTED	TO	CAUSE	SIGNIFICANT	INJURY	TO	A	HUMAN.
(2)	IN	ANY	APPLICATION,	INCLUDING	THE	ABOVE,	RELIABILITY	OF
OPERATION	OF	THE	SOFTWARE	PRODUCTS	CAN	BE	IMPAIRED	BY
ADVERSE	FACTORS,	INCLUDING	BUT	NOT	LIMITED	TO
FLUCTUATIONS	IN	ELECTRICAL	POWER	SUPPLY,	COMPUTER
HARDWARE	MALFUNCTIONS,	COMPUTER	OPERATING	SYSTEM
SOFTWARE	FITNESS,	FITNESS	OF	COMPILERS	AND
DEVELOPMENT	SOFTWARE	USED	TO	DEVELOP	AN	APPLICATION,
INSTALLATION	ERRORS,	SOFTWARE	AND	HARDWARE
COMPATIBILITY	PROBLEMS,	MALFUNCTIONS	OR	FAILURES	OF
ELECTRONIC	MONITORING	OR	CONTROL	DEVICES,	TRANSIENT
FAILURES	OF	ELECTRONIC	SYSTEMS	(HARDWARE	AND/OR
SOFTWARE),	UNANTICIPATED	USES	OR	MISUSES,	OR	ERRORS	ON
THE	PART	OF	THE	USER	OR	APPLICATIONS	DESIGNER	(ADVERSE
FACTORS	SUCH	AS	THESE	ARE	HEREAFTER	COLLECTIVELY
TERMED	"SYSTEM	FAILURES").	ANY	APPLICATION	WHERE	A
SYSTEM	FAILURE	WOULD	CREATE	A	RISK	OF	HARM	TO
PROPERTY	OR	PERSONS	(INCLUDING	THE	RISK	OF	BODILY
INJURY	AND	DEATH)	SHOULD	NOT	BE	RELIANT	SOLELY	UPON	ONE
FORM	OF	ELECTRONIC	SYSTEM	DUE	TO	THE	RISK	OF	SYSTEM
FAILURE.	TO	AVOID	DAMAGE,	INJURY,	OR	DEATH,	THE	USER	OR
APPLICATION	DESIGNER	MUST	TAKE	REASONABLY	PRUDENT
STEPS	TO	PROTECT	AGAINST	SYSTEM	FAILURES,	INCLUDING	BUT
NOT	LIMITED	TO	BACK-UP	OR	SHUT	DOWN	MECHANISMS.
BECAUSE	EACH	END-USER	SYSTEM	IS	CUSTOMIZED	AND
DIFFERS	FROM	NATIONAL	INSTRUMENTS'	TESTING	PLATFORMS
AND	BECAUSE	A	USER	OR	APPLICATION	DESIGNER	MAY	USE
NATIONAL	INSTRUMENTS	PRODUCTS	IN	COMBINATION	WITH
OTHER	PRODUCTS	IN	A	MANNER	NOT	EVALUATED	OR
CONTEMPLATED	BY	NATIONAL	INSTRUMENTS,	THE	USER	OR



APPLICATION	DESIGNER	IS	ULTIMATELY	RESPONSIBLE	FOR
VERIFYING	AND	VALIDATING	THE	SUITABILITY	OF	NATIONAL
INSTRUMENTS	PRODUCTS	WHENEVER	NATIONAL	INSTRUMENTS
PRODUCTS	ARE	INCORPORATED	IN	A	SYSTEM	OR	APPLICATION,
INCLUDING,	WITHOUT	LIMITATION,	THE	APPROPRIATE	DESIGN,
PROCESS	AND	SAFETY	LEVEL	OF	SUCH	SYSTEM	OR
APPLICATION.
	



Technical	Support	and	Professional	Services
Visit	the	following	sections	of	the	award-winning	National	Instruments
Web	site	at	ni.com	for	technical	support	and	professional	services:

Support—Technical	support	resources	at	ni.com/support	include	the
following:

Self-Help	Resources—For	answers	and	solutions,	visit
ni.com/support	for	software	drivers	and	updates,	a	searchable
KnowledgeBase,	product	manuals,	step-by-step
troubleshooting	wizards,	thousands	of	example	programs,
tutorials,	application	notes,	instrument	drivers,	and	so	on.
Registered	users	also	receive	access	to	the	NI	Discussion
Forums	at	ni.com/forums.	NI	Applications	Engineers	make
sure	every	question	submitted	online	receives	an	answer.
Standard	Service	Program	Membership—This	program
entitles	members	to	direct	access	to	NI	Applications
Engineers	via	phone	and	email	for	one-to-one	technical
support,	as	well	as	exclusive	access	to	on	demand	training
modules	via	the	Services	Resource	Center.	NI	offers
complementary	membership	for	a	full	year	after	purchase,
after	which	you	may	renew	to	continue	your	benefits.
For	information	about	other	technical	support	options	in	your
area,	visit	ni.com/services	or	contact	your	local	office	at
ni.com/contact.

Training	and	Certification—Visit	ni.com/training	for	self-paced
training,	eLearning	virtual	classrooms,	interactive	CDs,	and
Certification	program	information.	You	also	can	register	for
instructor-led,	hands-on	courses	at	locations	around	the	world.
System	Integration—If	you	have	time	constraints,	limited	in-house
technical	resources,	or	other	project	challenges,	National
Instruments	Alliance	Partner	members	can	help.	To	learn	more,
call	your	local	NI	office	or	visit	ni.com/alliance.

If	you	searched	ni.com	and	could	not	find	the	answers	you	need,	contact
your	local	office	or	NI	corporate	headquarters.	You	also	can	visit	the
Worldwide	Offices	section	of	ni.com/niglobal	to	access	the	branch	office
Web	sites,	which	provide	up-to-date	contact	information,	support	phone
numbers,	email	addresses,	and	current	events.

javascript:WWW(WWW_Support)
javascript:WWW(WWW_KB)
javascript:WWW(WWW_Manuals)
javascript:WWW(WWW_Exchange)
javascript:WWW(WWW_SRC)
javascript:WWW(WWW_Service)
javascript:WWW(WWW_Contact)
javascript:WWW(WWW_Customer_Education)
javascript:WWW(WWW_Integration)
javascript:WWW(WWW_Global)


	



What	Do	You	Want	to	Do?
Select	the	topic	you	want	to	learn	more	about.
Glossary
The	NI	License	Manager	Environment
Understanding	the	NI	Software	License	Agreement
Common	Tasks

Activate	a	Product
Move	an	Activated	Product	to	Another	Computer
Deactivate	a	Product
Use	a	Network	License	Server
Switch	between	Concurrent	Licenses
Install	a	License	File
Activate	a	Product	for	Home	Use
Recover	a	Deleted	or	Damaged	License	File
Use	the	Local	License	Server
Automate	Activation
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Branch	Offices
Office Telephone	Number
Australia 1800	300	800
Austria 43	662	457990-0
Belgium 32	(0)	2	757	0020
Brazil 55	11	3262	3599
Canada 800	433	3488
China 86	21	5050	9800
Czech	Republic 420	224	235	774
Denmark 45	45	76	26	00
Finland 358	(0)	9	725	72511
France 33	(0)	1	57	66	24	24
Germany 49	89	7413130
India 91	80	41190000
Israel 972	0	3	6393737
Italy 39	02	41309277
Japan 0120-527196	/	81	3	5472	2970
Korea 82	02	3451	3400
Lebanon 961	(0)	1	33	28	28
Malaysia 1800	887710
Mexico 01	800	010	0793
Netherlands 31	(0)	348	433	466
New	Zealand 0800	553	322
Norway 47	(0)	66	90	76	60
Poland 48	22	3390150
Portugal 351	210	311	210
Russia 7	495	783	6851
Singapore 1800	226	5886
Slovenia 386	3	425	42	00



South	Africa 27	0	11	805	8197
Spain 34	91	640	0085
Sweden 46	(0)	8	587	895	00
Switzerland 41	56	2005151
Taiwan 886	02	2377	2222
Thailand 662	278	6777
Turkey 90	212	279	3031
United	Kingdom 44	(0)	1635	523545
United	States	(Corporate) 512	683	0100
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